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Back Cover
Get on the fast track to professional application development with Visual Basic .NET 2003. This practical,
hands-on tutorial expertly guides you through the fundamentals—using step-by-step exercises, code samples,
optimization tips, and real-world advice to accelerate your productivity. Work at your own pace, learning
core programming skills by selecting just the chapters and lessons you need. Upgrade your Visual Basic 6
applications quickly with the help of “Upgrade Notes” sidebars, a special upgrading index, and insights into
the enhanced Visual Basic .NET Upgrade Wizard. It’s everything you need to start creating .NET-connected
software now!
Discover how to:
• Create a compelling user interface with Toolbox controls, menus, and dialog boxes
• Use methods in the .NET Framework 1.1 class libraries
• Utilize the new debugging tools and structured error handlers to build robust code
• Manage data in your programs using collections, arrays, and string processing techniques
• Automate Microsoft Office applications and manage processes
• Manage Windows Forms and create graphics and animation effects
• Use inheritance and other new object-oriented programming capabilities
• Write custom code for printers and dialog boxes for printing
• Manage Access databases and create custom database applications with Microsoft ADO.NET
• Display HTML documents using Microsoft Internet Explorer
• Use Web Forms to build Internet interfaces
• Deploy Visual Basic .NET applications
• Port Visual Basic 6 programs to Visual Basic .NET
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teaching college courses in European history.
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At Microsoft Press, we use tools to illustrate our books for software developers and IT professionals. Tools
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Introduction
Microsoft Visual Basic .NET Step by Step—Version 2003 is a comprehensive introduction to Visual Basic
programming using the Microsoft Visual Basic .NET 2003 software. I’ve designed this course with a variety
of skill levels in mind so that new programmers can learn software development fundamentals in the context
of useful, real-world applications and experienced Visual Basic programmers can quickly master the essential
tools and programming techniques offered in the Visual Basic .NET upgrade. Complementing this
comprehensive approach is the book’s structure—six topically organized parts, 22 chapters, and more than 65
step-by-step exercises and sample programs. By using this book, you’ll quickly learn how to create
professional-quality Visual Basic .NET applications for the Microsoft Windows operating system and a
variety of Web browsers. You’ll also have fun!
Important

Visual Basic .NET 2003 is available in different editions and product configurations, including
Standard Edition. It is also distributed as a component in the Microsoft Visual Studio .NET 2003
programming suite, which includes the Microsoft Visual C# .NET, Microsoft Visual C++ .NET,
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Introduction
and Microsoft Visual J# .NET compilers and other .NET development tools. Visual Studio .NET
2003 is available in several different editions, including Professional Edition, Enterprise
Developer Edition, Enterprise Architect Edition, and Academic Edition. I’ve written this book to
be compatible with Visual Basic .NET 2003 Standard Edition, Visual Studio .NET 2003
Professional Edition, Visual Studio .NET 2003 Enterprise Developer Edition, and Visual Studio
.NET 2003 Enterprise Architect Edition. Although Visual Basic .NET 2003 is quite similar to
Visual Basic .NET 2002, there are a few Important differences, so I recommend that you
complete the exercises in this book using the Visual Basic .NET 2003 software.

Finding Your Best Starting Point in This Book
This book is designed to help you build skills in a number of essential areas. You can use this book if you’re
new to programming, switching from another programming language, or upgrading from Microsoft Visual
Basic 6. Use the following table to find your best starting point in this book.
If you are
New
To programming

Follow these steps

1. Install the practice files as described in the
section “Installing the Practice Files on Your
Computer.”
2. Learn basic skills for using Microsoft Visual
Basic .NET by working sequentially from
Chapter 1 through Chapter 18.
3. Complete Parts 5 and 6 as your level of
interest or experience dictates.
Switching
From Microsoft QuickBasic or an earlier version of
the BASIC programming language

1. Install the practice files as described in the
section “Installing the Practice Files on Your
Computer.”
2. Complete Chapter 1 through Chapter 4, skim
Chapter 5 through Chapter 7, and complete
Parts 3 and 4 sequentially.
3. For specific information about creating
database and Internet programs, read Parts 5
and 6, respectively.

Upgrading
From Microsoft Visual Basic 6
1. Install the practice files as described in the
section “Installing the Practice Files on Your
Computer.”
2. Read Chapter 1 through Chapter 4 carefully to
learn the new features of the Visual Studio
.NET development environment.
3. Pay special attention to the “Upgrade Notes:
What’s New in Visual Basic .NET?” sidebars
near the beginning of each chapter, which
highlight the significant differences between
Visual Basic 6 and Visual Basic .NET.
4. Skim Chapter 5 through Chapter 7 to review
the fundamentals of event-driven
programming, using variables, and writing
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decision structures.
5. Work sequentially from Chapter 8 through
Chapter 22 to learn the new features of Visual
Basic .NET.
6. Read Appendix A: “Upgrading Visual Basic 6
Programs to Visual Basic .NET 2003” to
learn how to convert Visual Basic 6 programs
using the Visual Basic Upgrade Wizard.

Referencing
This book after working through the chapters
1. Use the index to locate information about
specific topics, and use the table of contents
to locate information about general topics.
2. Use the Upgrading Index to see a list of the
new features in Visual Basic .NET and how
Visual Basic 6 program code should be
upgraded.
3. Read the Quick Reference at the end of each
chapter for a brief review of the major tasks in
the chapter. The Quick Reference topics are
listed in the same order as they’re presented
in the chapter.

Visual Basic 6 vs. Visual Basic .NET: New Features and
Concepts
The following table lists the major new features in both Microsoft Visual Basic .NET 2002 and Microsoft
Visual Basic .NET 2003 that are covered in this book. The table is designed to identify features that a typical
Visual Basic 6 programmer will be interested in, and it shows the chapter in which you can find more
information about the feature described. You can also use the Upgrading Index or the general index to find
specific information about a feature or a task you want to learn.
To learn how to
Use the new integrated Visual Studio .NET development environment
and programming tools
Find an executive summary of improvements and new features in the
Visual Basic .NET 2003 upgrade
Use the new Windows Forms Toolbox controls, including
DateTimePicker and LinkLabel
Compile your program as debug builds and release builds
Use the new MainMenu control and new dialog box controls
Use methods in the new .NET Framework in program code
Master the new variable types and math shortcut operators
Understand changes in While loops and Timer controls
Use the new debugging features in Visual Basic .NET
Use the new Try…Catch syntax for building error handlers
Learn the new syntax for declaring and calling procedures
Use Visual Basic .NET collections
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Chapter 1
Chapter 1
Chapters 2 and 3
Chapter 2
Chapter 4
Chapter 5
Chapter 5
Chapter 7
Chapter 8
Chapter 9
Chapter 10
Chapter 11
Chapter 12
7
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Use new file and string processing methods in the System.IO namespace
and String class
Work with older ActiveX (COM) objects in Visual Basic .NET
Use a Process component to manage a running application
Deploy Visual Basic .NET applications and assemblies
Use the System.Drawing namespace to create graphics and animation
effects
Use inheritance in programs
Print graphics and text by using new methods, classes, and controls
Use Server Explorer and Microsoft ADO.NET techniques to manage
databases
Create data adapters and datasets
Use Web Forms controls to build interactive Web applications
Use the new Web Forms Designer to build Web pages
Use Microsoft ASP.NET for Internet programming

Chapters 3 and 13
Chapter 13
Chapter 14
Chapter 16
Chapter 17
Chapter 18
Chapters 19 and 20
Chapters 19 and 20
Chapter 22
Chapter 22
Chapter 22

About the Companion CD-ROM
The CD-ROM inside the back cover of this book contains a fully searchable electronic version of the book.
This eBook allows you to view the book text on screen and to search the contents. For information on
installing and using the eBook, see the Readme.txt file in the \eBook folder.
The CD-ROM also contains practice files that you’ll use as you perform the exercises in the book. For
example, when you’re learning how to display database records with an ADO.NET dataset, you’ll open one of
the practice files— an academic database named Students.mdb—and then use ADO.NET commands to
access the database. By using the practice files, you won’t waste time creating all the samples used in the
exercises. Instead, you can concentrate on learning how to master Visual Basic .NET 2003 programming
techniques. With the files and the step-by-step instructions in the chapters, you’ll also learn by doing, which is
an easy and effective way to acquire and remember new skills.
Important

Before you break the seal on the CD-ROM, be sure that this book matches your version of the
software. This book is designed for use with Microsoft Visual Basic .NET 2003 and Microsoft
Visual Studio .NET 2003 for the Microsoft Windows operating system. To find out what
software you’re running, you can check the product package, or you can start the software, open
a project, and then click About Microsoft Visual Basic .NET on the Help menu at the top of the
screen.

System Requirements
To compile and run all the practice files on this book’s companion CD-ROM, you’ll need the following
configuration:
• Microsoft Windows 2000 Professional, Windows 2000 Server, Windows XP Home Edition, Windows
XP Professional, Windows Server 2003 or later
• Microsoft Visual Basic .NET 2003, which can be one of the following editions:
♦ Visual Basic .NET 2003 Standard
♦ Visual Studio .NET 2003 Professional
♦ Visual Studio .NET 2003 Enterprise Developer
8
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♦ Visual Studio .NET 2003 Enterprise Architect
Important A few features (such as the Setup Wizard, the Cab Project template, the Merge Module
Project template, and the Web Setup Project template discussed in Chapter 14) aren’t
included in Visual Basic .NET 2003 Standard. Also, because Windows XP Home
Edition doesn’t include Microsoft Internet Information Services, you can’t create local
ASP.NET Web applications (discussed in Chapter 22) using Windows XP Home
Edition.
This book and the practice files were tested using Visual Basic .NET 2003 Standard and Visual Studio .NET
2003 Professional. You might notice a few differences if you’re using other editions of Visual Studio .NET
2003.

Installing the Practice Files on Your Computer
Installing the practice files on your hard disk requires approximately 5.5 MB of disk space. Follow these steps
to install the practice files on your computer’s hard disk so that you can use them with the exercises in this
book.
1. Remove the CD-ROM from the package inside the back cover of this book, and insert it in your
CD-ROM drive.
Important

On many systems, Windows will automatically recognize that you’ve inserted a
CD-ROM and will display a start window. If this happens, skip to step 4.
2. On the taskbar at the bottom of your screen, click the Start button, and then click Run.
The Run dialog box appears.
3. In the Open text box, type d:\startcd, and then click OK. Don’t add spaces as you type. (If your
CD-ROM drive is associated with a different drive letter, such as E, type that instead.)
A start window should appear.
4. Click Install Practice Files in the list of options on the left.
A Setup program appears.
5. Follow the directions on the screen.
The Setup program will copy the practice files from the CD-ROM to your hard drive and clear the
Read-only flag on the files. For best results in using the practice files with this book, accept the
preselected installation location, which by default is c:\vbnet03sbs. (If you change the installation
location, you’ll need to manually adjust the paths in a few practice files to locate essential
components—such as artwork and database files—when you use them.)
6. When the files have been installed, remove the CD-ROM from your CD-ROM drive and replace it in
the package inside the back cover of your book.
A folder named c:\vbnet03sbs has been created on your hard disk, and the practice files have been
placed in that folder. You’ll find one folder in c:\vbnet03sbs for each chapter in the book. If you have
trouble running any of the practice files, refer to the text in the book that describes those files.
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Using the Practice Files
Each chapter in this book explains when and how to use the practice files for that chapter. When it’s time to
use a practice file, the book will list instructions for how to open the file. The chapters are built around
scenarios that simulate real programming projects so that you can easily apply the skills you learn to your own
work.
Notice that Visual Basic .NET 2003 features a new file format for its projects and solutions. Accordingly, you
won’t be able to open the practice files for this book if you’re using an older version of the Visual Basic or
Visual Studio software. To check the version of Visual Basic or Visual Studio that you’re using, click the
About command on the Help menu.
For those of you who like to know all the details, here’s a list of the Visual Basic projects included on the
CD-ROM. Each project is located in its own folder and has several support files.
Project
Chapter 1
MusicTrivia
Chapter 2
Lucky7
Chapter 3
Birthday
CheckBox
Hello
Input Controls
WebLink
Chapter 4
Dialog
Menu
Chapter 5
Advanced Math
Basic Math
Constant Tester
Data Types
Framework Math
Input Box
Variable Test
Chapter 6
Case Greeting
Password Validation

10

Description
A simple trivia program that welcomes you to the programming course
and displays a digital photo.
Your first program—a Lucky Seven Slot Machine game that simulates a
Las Vegas one-armed bandit.
A program that uses the DateTimePicker control to pick a date.
A program that demonstrates the CheckBox control and its properties.
A “Hello, world!” program that demonstrates the Label and TextBox
controls.
The user interface for an electronic shopping program, assembled using
several powerful input controls.
A demonstration of the new Windows Forms LinkLabel control.
Demonstrates how to use the Visual Basic .NET dialog box controls.
Shows how menus and commands are added to a form.
Advanced use of operators for integer division, remainder division,
exponentiation, and string concatenation.
Basic use of operators for addition, subtraction, multiplication, and
division.
Uses a constant to hold a fixed mathematical entity.
A demonstration of different fundamental data types and their use with
variables.
Demonstrates the .NET Framework classes with mathematical methods.
Receives input with the InputBox function.
Declares and uses variables to store information.
Uses the Case statement in a program to display an appropriate
foreign-language welcome message.
Uses the And logical operator to check for logon password.

Introduction

Introduction
User Validation
Chapter 7
Celsius Conversion
Counter Variable
Digital Clock
For Loop
For Loop Icons
Timed Password
Chapter 8
Debug Test
Chapter 9
Disk Drive Error
Disk Drive Handler
Chapter 10
Final Track Wins
Module Test
Text Box Sub
Track Wins
Chapter 11
Controls Collection
Dynamic Array
Fixed Array
URL Collection
Chapter 12
Encrypt Text
Quick Note
Sort Text
Text Browser
Xor Encryption
Chapter 13
Excel Automation
Excel Sheet Tasks
Start App
Chapter 14
Lucky Seven

11
Uses If…Then…Else to manage the logon process.
Converts temperatures by using a Do loop.
Uses an incremental counter as opposed to a loop to process data.
A simple digital clock utility.
Executing code with a For…Next loop.
Demonstrates using the counter in a loop to display icons.
A logon program with a password time-out feature.
A simulated debugging problem, designed to be solved using the Visual
Studio .NET debugging tools.
A program that crashes when a floppy disk drive is used incorrectly.
(This project is used as the basis of a Visual Basic .NET error handler.)
A project with a completed error handler that demonstrates the
Try…Catch syntax.
Uses a public variable to track the number of wins in the Lucky Seven
Slot Machine project.
Creating a new code module in a project.
A general-purpose Sub procedure that adds items to a list box.
A clean version of the Lucky Seven Slot Machine project from Chapter 2
(the basis of the Final Track Wins project).
Uses a Visual Basic .NET collection to move objects on a form.
Computes the average temperature for any number of days by using a
dynamic array.
Computes the average weekly temperature by using a fixed-length array.
Demonstrates a user-defined collection containing a list of Web
addresses (URLs) recently visited by the user.
Encrypts text files by shifting ASCII characters.
A simple note-taking utility.
A text file editor that demonstrates the Shell sort.
Displays the contents of a text file in a Visual Basic .NET program.
Encrypts text files by using the Xor operator.
Calls Microsoft Excel 2002 from Visual Basic .NET to compute a loan
payment.
Uses Automation to insert text and execute basic formatting in an Excel
2002 worksheet.
Starts and controls a Windows application process from within a Visual
Basic .NET program.
Demonstrates how Visual Basic .NET applications are compiled and
deployed using the Setup Wizard and other tools.

Chapter 15
Introduction
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Add Controls
Anchor and Dock
Desktop Bounds
Lucky Seven
Multiple Forms
Startup Form
Chapter 16
Draw Shapes
Moving Icon
Transparent Form
Zoom In
Chapter 17
Class Inheritance
Form Inheritance
Person Class

Chapter 18
Print Dialogs
Print File
Print Graphics
Print Text
Chapter 19
ADO Form
Chapter 20
DataGrid Sample
Chapter 21
Explorer Objects

Show HTML
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Demonstrates how controls are added to a Windows Form at runtime by
using program code (not the Windows Forms Designer).
Uses the Anchor and Dock properties of a form to align objects at
runtime.
Uses the StartPosition and DesktopBounds properties to position a
Windows Form at runtime.
Lucky Seven Slot Machine project that’s used as the basis of the
Multiple Forms project. (Open this project when you start the chapter.)
A revision of the Lucky Seven Slot Machine project that uses a second
form to display online Help.
Demonstrates how the startup (opening) form can be switched between
Form1, Form2, and the Sub Main procedure.
Demonstrates a few of the new graphics methods in the System.Drawing
namespace.
Animates an icon on the form, moving it from the top of the form to the
bottom each time that you click the Move Down button.
Demonstrates how to change the transparency of a form.
Simulates zooming in, or magnifying, an object on a form (in this case,
the planet Earth).
Demonstrates the inheritance feature of the Visual Basic .NET
object-oriented programming model.
Uses the Visual Studio .NET Inheritance Picker to create a form that
inherits its characteristics and functionality from another form.
Demonstrates how new classes are created in a Visual Basic .NET
project. The new class is called Person, an employee record with first
name, last name, and date of birth fields. The class also contains a
method that computes the current age of an employee.
Demonstrates how to create Print Preview and Page Setup dialog boxes.
A project that handles more sophisticated printing tasks, including
printing a multipage text file with wrapping lines.
Prints graphics from within a Visual Basic .NET program.
Demonstrates how simple text is printed in a Visual Basic .NET
program.
Demonstrates how ADO.NET is used to establish a connection to a
Microsoft Access database and display information from it.
Shows how the DataGrid control is used to display an entire record or
collection of records on a form.
A project that demonstrates how a reference is made to the Microsoft
Internet Controls library and how a COM wrapper is generated within a
project. This exercise also instructs readers on how to use the Visual
Studio .NET Object Browser tool.
Allows the user to pick one of several Web sites from a list box and then
uses Microsoft Internet Explorer to display the selected Web site or
Introduction

Introduction
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HTML document.

Chapter 22
WebCalculator
Appendix A
AlarmVB6
AlarmVB.NET

Demonstrates using Web Forms controls and ASP.NET to create a car
loan calculator that runs in an Internet browser.
A sample Visual Basic 6 program.
A Visual Basic .NET 2003 program that was upgraded from Visual
Basic 6 using the Visual Basic Upgrade Wizard.

Uninstalling the Practice Files
Use the following steps to delete the practice files added to your hard drive by the Visual Basic .NET Step by
Step—Version 2003 installation program.
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click the Add/Remove Programs icon.
The Add/Remove Programs window appears.
3. Select Visual Basic .NET 2003 SBS from the list, and then click Change/Remove.
A confirmation message appears.
4. Click Yes.
The practice files are uninstalled.
5. Close the Add/Remove Programs window.
6. Close the Control Panel window.

Conventions and Features in This Book
You can save time when you use this book by understanding, before you start the exercises, how I offer
instructions and the elements I use to communicate information about Visual Basic .NET programming.
Please take a moment to read the following list, which identifies stylistic issues and discusses helpful features
of the book that you might want to use. A few conventions are especially useful for readers who plan to
upgrade Visual Basic 6 applications to Visual Basic .NET 2003.

Conventions
• Hands-on exercises for you to follow are given in numbered lists of steps (1, 2, and so on). A round
bullet (•) indicates an exercise that has only one step.
• Text that you need to type appears in boldface type.
• As you work through steps, you’ll occasionally see tables with lists of properties that you’ll type into
Visual Studio. Text properties appear within quotes, but you don’t need to type the quotes.
• A plus sign (+) between two key names means that you must press those keys at the same time. For
example, “Press Alt+Tab” means that you hold down the Alt key while you press Tab.
• Elements labeled Note, Tip, or Important provide additional information or alternative methods for a
step that you should read before continuing with the lesson.
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Other Features of This Book
• You can learn special programming techniques, background information, or features related to the
information being discussed by reading the shaded sidebars that appear throughout the chapters.
These sidebars often highlight difficult terminology or suggest future areas for exploration.
• You can learn about options or techniques that build on what you learned in a chapter by trying the
optional One Step Further exercise at the end of that chapter.
• You can get a quick reminder of how to perform the tasks you learned by reading the Quick
Reference at the end of a chapter.

Upgrading Visual Basic 6 Programs
If you’re upgrading from Visual Basic 6 to Visual Basic .NET 2003, you should be aware of three features in
this book that are designed to help you evaluate and upgrade your existing projects quickly. Those features are
• The Upgrading Index, located before the comprehensive index, which lists in one place the major
differences between Visual Basic 6 and Visual Basic .NET and provides page citations to information
in the book about these differences.
• “Upgrade Notes” sidebars, near the beginning of each chapter, which provide a basic overview, or
executive summary, of the features in Visual Basic .NET. Use these sidebars if you’re interested in
how Visual Basic .NET has changed in the context of an individual topic, such as variable
declaration, Toolbox controls, or database programming.
• Appendix A, “Upgrading Visual Basic 6 Programs to Visual Basic .NET 2003,” which is located
immediately after Chapter 22. This appendix describes how to evaluate your existing Visual Basic 6
programs and how to upgrade them to Visual Basic .NET 2003 by using Internet resources and the
Visual Basic Upgrade Wizard.

Corrections, Comments, and Help
Every effort has been made to ensure the accuracy of this book and the contents of the companion CD-ROM.
If you run into a problem, Microsoft Press provides corrections for its books through the World Wide Web at
the following Web site:
http://www.microsoft.com/mspress/support/
If you have problems, comments, or ideas regarding this book or the companion CD-ROM, please send them
to Microsoft Press.
Send e-mail to
mspinput@microsoft.com
Or send postal mail to
Microsoft Press
Attn: Microsoft Visual Basic .NET Step by Step—Version 2003 Editor
One Microsoft Way
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Redmond, WA 98052-6399
Please note that support for the Visual Basic .NET software product itself is not offered through the preceding
addresses.

Visual Basic .NET Software Support
For help using Visual Basic .NET in North America, you can call the Microsoft Professional Support for
Developers line at 1-800-936-5800. This service is currently available 24 hours a day and is a charge-based
service. (Your version of Visual Basic .NET or Visual Studio .NET might provide free phone support for a
limited time.) You’ll be connected to a live, trained Visual Studio .NET professional when you call the
support number, not an endless series of phone recordings. Check your Visual Basic .NET product
documentation for the details of your service agreement.

Visit the Microsoft Press World Wide Web Site
You’re also invited to visit the Microsoft Press World Wide Web site at the following location:
http://www.microsoft.com/mspress/
You’ll find descriptions for the complete line of Microsoft Press books (including others by Michael
Halvorson), information about ordering titles, notice of special features and events, worldwide contact
information, additional content for Microsoft Press books, and much more.
You can also find out the latest in Visual Basic software developments and news from Microsoft Corporation
by visiting the following World Wide Web site:
http://www.microsoft.com/vbasic/
Get on line and check it out!
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Overview
In this chapter, you will learn how to:
• Start Microsoft Visual Studio .NET 2003.
• Use the Visual Studio development environment.
• Open and run a Microsoft Visual Basic program.
• Change a property setting.
• Move, resize, dock, and auto hide tool windows.
• Use online Help and exit Visual Studio.
Microsoft Visual Basic .NET 2003 is an important upgrade and enhancement of the popular Visual Basic
development system and an iterative upgrade of the Visual Basic .NET 2002 software. This chapter introduces
you to what’s new in Visual Basic .NET and gives you the skills you will need to get up and running with the
Visual Studio .NET 2003 development environment quickly and efficiently. You should read this chapter
whether you are new to Visual Basic .NET programming or you have used previous versions of the Visual
Basic compiler. The most important advantage of Visual Basic .NET is that it has been designed to make you
even more productive in your daily development work—especially if you need to use information in databases
or create solutions for the Internet—but an important additional benefit is that once you become comfortable
with the development environment in Visual Studio, you can use the same tools to write programs for
Microsoft Visual C++ .NET, Microsoft Visual C# .NET, Microsoft Visual J# .NET, and other third-party
tools and compilers.
The first version of Visual Basic .NET (Visual Basic .NET 2002) was released in February 2002. The second
release (Visual Basic .NET 2003) was generally available in March 2003. Visual Basic .NET 2003 contains
several technical additions and performance enhancements, including the Visual J# .NET programming
language, version 1.1 of the Microsoft .NET Framework, integration with Microsoft Windows Server 2003,
and support for mobile computing through a compact version of the .NET Framework. Visual Basic .NET
2003 also offers a new and enhanced file format for projects and solutions, which means that older versions of
Visual Basic and Visual Basic .NET won’t be able to open Visual Basic .NET 2003 projects. However, Visual
Basic .NET 2002 projects and solutions are automatically upgraded to Visual Basic .NET 2003 when they’re
opened the first time—there is, in other words, great compatibility between the products.
In this chapter, you’ll learn how to start Visual Basic .NET 2003 and how to use the integrated development
environment to open and run a simple program. You’ll learn the essential Visual Studio menu commands and
programming procedures; you’ll open and run a simple Visual Basic program named MusicTrivia; you’ll
change a programming setting called a property; and you’ll practice moving, sizing, docking, and auto hiding
tool windows. You’ll also learn how to get more information by using online Help and how to exit the
development environment safely.

Upgrade Notes: What’s New in Visual Basic .NET?
Upgrading from Visual Basic 6 to Visual Basic .NET involves a unique set of challenges, and the migration
process continues to be an important topic even after the release of Visual Basic .NET 2003. For this reason, I
begin each chapter in this book with a sidebar that highlights the general changes between Visual Basic 6 and
Visual Basic .NET. Remember that you don’t need any programming experience to learn Visual Basic .NET
2003 using this book. But if you have some Visual Basic 6 knowledge already or some Visual Basic 6 code
16
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that you need to upgrade, I want to give you a short executive summary of the differences. So to begin with,
here is my list of Visual Basic .NET upgrade notes for this chapter:
• Visual Basic is now fully part of Visual Studio—it shares the Visual Studio development environment
with Visual C++ .NET, Visual C# .NET, Visual J# .NET, and several other programming tools.
Although Visual Basic .NET and Visual C++ .NET are still different programming languages, they
share the same development environment.
• As part of its new development environment, Visual Studio offers a new Start Page pane, which
shows recently used projects and lets you open new or existing source files. Additional links in the
Start Page pane provide you with access to Visual Studio Web sites, profile information, and contacts
in the Visual Studio development community.
• The Visual Studio development environment contains several new and modified programming tools.
The Project window is now called Solution Explorer, and there is a context-sensitive help window
called Dynamic Help. You’ll find that the Toolbox has changed quite a bit— it’s now subdivided into
several functional categories, from Windows Forms to Web Forms to Data.
• Most of the programming tool windows have an auto hide feature to hide the tool as a tab when it
isn’t needed.
• Projects are now saved in a different way. You give your project a name before you create it. The
project itself now is spread over several files and folders—even more than in Visual Basic 6. In
Visual Basic 6, programs that were made up of multiple projects were called project groups; now
they’re called solutions.

The Visual Studio .NET Development Environment
Although the programming language you’ll be learning in this book is Visual Basic, the development
environment you’ll be using to write programs is called the Microsoft Visual Studio .NET development
environment. Visual Studio is a powerful and customizable programming workshop that contains all the tools
you need to build robust programs for Windows quickly and efficiently. Most of the features in Visual Studio
apply equally to Visual Basic .NET, Visual C++ .NET, Visual C# .NET, and Visual J# .NET. Use the
following procedures to start Visual Studio now.
Important

If you haven’t yet installed this book’s practice files, work through “Finding Your Best Starting
Point” and “About the CD-ROM and Practice Files” at the beginning of the book. Then return to
this chapter.

Start Visual Studio .NET 2003
1. On the Windows taskbar, click the Start button, point to Programs, and then point to the Microsoft
Visual Studio .NET 2003 folder. The icons in the Microsoft Visual Studio .NET 2003 folder appear in
a list.
Note To perform the steps in this book, you must have one of the following Visual Studio .NET 2003
editions installed: Visual Basic .NET Standard, Visual Studio .NET Professional, Visual Studio
.NET Enterprise Developer, or Visual Studio .NET Enterprise Architect. Also—don’t try to use
this book if you have an earlier version of the Visual Basic software; if that’s your situation,
you’ll be better served by locating an earlier edition of my book, such as the first edition of
Microsoft Visual Basic .NET Step by Step (which describes the Visual Basic .NET 2002
software) or Microsoft Visual Basic Professional 6.0 Step by Step, which describes the Visual
Basic 6 software.
2. Click the Microsoft Visual Studio .NET 2003 program icon.
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Visual Studio starts, and you see the development environment on the screen with its many menus,
tools, and component windows. (These windows are sometimes called tool windows.) If this is a new
installation of Visual Studio, you should see a Start Page with a set of links. (If you don’t see the Start
Page, click Show Start Page on the Help menu.)

3. On the right side of the Start Page window, click the My Profile link.
Visual Studio displays the My Profile settings. The My Profile pane allows you to configure Visual
Studio with your personal preferences. This is an important screen because Visual Studio can be used
to build different types of programs (Visual Basic, Visual C++, and so on), so you want to identify
yourself as a Visual Basic developer right away.
4. In the Profile drop-down list box, select Visual Basic Developer from the list of choices.
Visual Studio immediately configures the development environment for Visual Basic programming,
displays the Toolbox, and makes adjustments to window characteristics and code formatting styles so
that your programs will look like standard Visual Basic solutions.
5. In the At Startup drop-down list box, be sure that Show Start Page is selected.
Setting this option will ensure that the Start Page will appear each time you open Visual Studio.

6. Investigate a few of the remaining settings&"last-para">You can come back to My Profile at any time
in the future to fine- tune your profile selections. They will mean more to you after you’ve written a
few programs and have looked at some of the Visual Basic code your friends and coworkers have
produced.
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The first thing most developers do when they start Visual Studio is open an existing project—either a
completed solution they want to work with again or an ongoing development project. Try opening an existing
project now that I created for you—the MusicTrivia program.

Open a Visual Basic project
1. Click the Projects tab and then the Open Project button at the bottom of the Start Page.
The Open Project dialog box appears on the screen with several options. Even if you haven’t used
Visual Basic before, the Open Project dialog box will seem straightforward, like the familiar Open
box in Microsoft Word or Microsoft Excel.

Tip In the Open Project dialog box, you&"listitem">
Browse to the folder c:\vbnet03sbs on your hard disk.
The folder c:\vbnet03sbs is the default location for this book’s extensive sample file collection,
and you’ll find the files there if you followed the setup instructions in “About the CD-ROM and
Practice Files” at the beginning of this book. If you didn’t install the sample files, do so now
using the CD-ROM included with this book.
2. Open the chap01\musictrivia folder, and then double-click the MusicTrivia project file
(MusicTrivia.vbproj).
Visual Studio loads the MusicTrivia form, properties, and program code for the MusicTrivia project.
The Start Page probably will still be visible, but Solution Explorer in the upper right corner of the
screen will list some of the files in the project.
Tip If you don’t see filename extensions in the Open Project dialog box, the hide file extensions
option might be turned on. You can change this option in Windows Explorer. On the Tools menu
in Windows Explorer, click Folder Options. On the View tab of the Folder Options dialog box,
you can uncheck the Hide File Extensions For Known File Types check box.
Trouble?
If you see an error message indicating that the project you want to open is in a newer file format,
you might be trying to load Visual Basic .NET 2003 files into the older Visual Basic .NET 2002
software. (The Visual Basic .NET 2002 software cannot open the Visual Basic .NET 2003
projects included on the companion CD-ROM.) To check which version of Visual Studio .NET
you’re using, click the About command on the Help menu.

Projects and Solutions
In Visual Studio, programs in development are typically called projects or solutions because they contain
many individual components, not just one file. Visual Basic .NET programs include a project file (.vbproj)
Chapter 1: Opening and Running a Visual Basic .NET 2003 Program

19

20

Chapter 1: Opening and Running a Visual Basic .NET 2003 Program

and a solution file (.sln). A project file contains information specific to a single programming task. A solution
file contains information about one or more projects. Solution files are useful to manage multiple related
projects and are similar to project group files (.vbg) in Visual Basic 6. The samples included with this book
typically have a single project for each solution, so opening the project file (.vbproj) will have the same effect
as opening the solution file (.sln). But for a multi-project solution, you will want to open the solution file.
Visual Basic .NET 2003 offers a new file format for its projects and solutions, but the same basic terminology
still applies.

The Visual Studio .NET Tools
At this point, you should take a few moments to study the development environment and identify some of the
programming tools and windows that you’ll be using as you complete this course. If you’ve written Visual
Basic 6 programs before, you’ll recognize many (but not all) of the development tools. (The Visual Basic
.NET 2002 tools and the Visual Basic .NET 2003 tools are largely the same.) Collectively, these features are
the components that you use to construct, organize, and test your Visual Basic programs. A few of the
programming tools also help you learn more about the resources on your system, including the larger world of
databases and Web site connections available to you. There are also several powerful online Help tools.
The menu bar provides access to most of the commands that control the development environment. Menus
and commands work as they do in all Windows- based programs, and you can access them by using the
keyboard or the mouse. Located below the menu bar is the Standard toolbar, a collection of buttons that serve
as shortcuts for executing commands and controlling the Visual Studio development environment. If you’ve
used Excel or Word, the toolbar should be a familiar concept. To activate a button on the toolbar, click the
button using the mouse. Along the bottom of the screen is the Windows taskbar. You can use the taskbar to
switch between various Visual Studio .NET components and to activate other Windows-based programs. You
might also see taskbar icons for Microsoft Internet Explorer and other programs.
The following illustration shows some of the tools, windows, and other elements in the Visual Studio
development environment. Don’t worry that this illustration looks different from your current development
environment view. You’ll learn more about these elements as you step through the chapter.

The main tools that you&"52">
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